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Highlights 

Industry-leading Information Visualization 

Capture, organize and work with ideas and information in a wide variety of interactive visual formats including 

information maps, outlines, organization charts, tree diagrams and more. 

Project Planning and Task Management 

Streamline the project planning process and ensure visibility into all aspects of a project. Easily gather 

requirements and gain stakeholder buy-in on strategies, schedules and more. Assign and track priorities, resources 

and schedules to ensure project details stay on schedule. 

Capture Content and Add Context 

Easily capture stakeholder input, draw connections and reorder content. Use icons, tags, topic shapes, callouts, 

boundaries, colors, topic sorting and numbering to provide additional context. Add hyperlinks, attachments, notes 

and images to provide additional levels of details. 

Information Map Presentations 

Communicate effectively to multiple audiences with MindManager’s interactive slide presentations. Easily tailor 

the level of details presented for each audience and capture critical feedback right in the presentation. 

Integration and Sharing 

Save time with powerful integrations. Import from Microsoft® Word®, Apple® iWork® Pages and FreeMind. Export 

to Word, Pages or Keynote® for your final output. Integrate with iChat® to send or receive maps during a chat 

session. And share your maps via email, as web pages, images or dynamic PDF files. 

Dynamic Content 

Synchronize your relevant calendar items and contacts with MindManager with dynamic Microsoft® Entourage 

and Apple iCal® and Address Book dashboards. Bring the Internet into the map with a built-in web browser for in-

context search and research results. 

Navigation, Viewing and Printing Controls 

Navigate and control the levels of details displayed with powerful features like topic focus, show or hide branch, 

collapse map, quick filter and select, and more. Automatically fit or balance your map within the screen. Use 

WYSIWYG printing of entire maps or selected sections  

Lion 10.7 OS X Certified 

MindManager Version 9 for Mac is fully compatible with Lion 10.7 OS X, in addition to Snow Leopard 10.6 OS X. 

 

  



Features 
Mindjet Connect Integration 

 Improve team dynamics by increasing project management transparency, accountability, and productivity 

by sharing maps and files with other team members.  

 Sign into Mindjet Connect and Share maps with team members 

 Store maps and files in Mindjet Connect, you and invited team members can check them in and out to 

make edits  

 Invite anyone to access your files and grant them read-only or edit access 

 Access your maps with a browser or Mindjet’s mobile apps.  

Slide Presentations 

 Present your work in easy to follow slides. Pick and choose topics to present, adjust their order and 

control exactly how you want each branch to appear. 

 Display your slides in a MindManager slideshow, or export them to create a Keynote or PowerPoint 

presentation. 

WYSIWYG Printing 

 Now printing your maps is easier than ever. Choose to print the entire map or only select slides, so you 

can print out exactly what you need. 

Improved Interface 

Find exactly what you are looking for with an improved organization of menu options and enhanced user interface. 

  New Map Gallery makes it easier to get started by choosing a template or resume working on an existing 

map. 

 Formatting Toolbar – gives you access to commands for formatting and editing map elements quickly. 

 Improved Inspector – Inspectors have been modified for improved usability. Open multiple Inspectors to 

get quick access to the options you use most. 

 Improved Notes – Topic Notes can now be formatted in-context in the Notes window. 

Local, Expanded Import and Export Transformations 

 No longer do you need an internet connection to import or export files. Now you can take advantage of 

in-product compatibility with MS Office Mac 2011 and iWork 09. 

 More export types let you export your map or slides in a variety of formats.  

 Now you can easily import your FreeMind maps into MindManager. 

Improved Filtering and Select 

 Filtering and selecting map elements is more intuitive with helpful tool tips, and easier creation and use of 

saved rules. 

Quick Entry Mode 

 Quickly enter and organize ideas into a map for an improved brainstorming and mapping experience. 

Improved Imagery, Styles and Templates 

 Choose from a selection of new business-oriented icons, images, templates and styles designed to 

enhance presentations and provide more context to maps. 

 

 

  



Resolved Issues in Version 9.5.416 
Issue: Text does not adjust within "New Resources from Address Book" selection window, when the 

window is resized. 

Resolved: Text adjusts to resizing of window. 

Issue: Map Gallery becomes unresponsive and panels lose the content when open. 

Resolved: Template gallery doesn’t lock.  

Issue: Lion: Crash occurs when closing opened maps. 

Resolved: No crash. 

Issue: Crash occurs on quit.   

Resolved: No crash. 

Issue: Crash occurs when paste multi-lined text on boundary. 

Resolved: No crash. 

 

Resolved Issues in Version 9.0.214 
Issue: Crash occurs when opening particular maps. 

Resolved: No crash occurs. 

Issue: Attachments do not open in Lion OS. 

Resolved: Attachments open correctly. 

Issue: Background’s opacity value wasn’t accepted in Snow Leopard OS. 

Resolved: Ability to adjust values has been restored. 

Issue: <OK> button in the File Info dialog is greyed out in Lion OS. 

Resolved: <OK> button is enabled. 

 

Resolved Issues in Version 9.0.194 
Issue: Some icons on the Toolbar look disabled when topic is selected. 

Resolved: Toolbar icons only appear disabled if not applicable. 

Issue: Crash occurs when topics with boundaries are deleted via <command delete> keyboard shortcut. 

Resolved: No crash occurs. 

Issue: Consistent crash on quitting MindManager. 

Resolved: No crash occurs upon quitting MindManager. 

Issue: Error message for Export is not localized. 

Resolved: Error message for Export is localized. 

Issue: Tree & split-tree layouts aren’t centered by default. 

Resolved: Tree & split-tree layouts are now centered by default. 

Issue: Crash occurs when opening a map with a hidden floating slide topic. 

Resolved: No crash occurs. 

Issue: File > Export disabled, unless map is saved. 

Resolved: File > Export enabled at all times; user is alerted to Save map (if not already saved). 



Issue: Japanese: Search for images in Library doesn’t work. 

Resolved: Search for images in Library now works. 

Issue: German, French, Japanese: Task information doesn’t get exported on simple topics. 

Resolved: Task information now gets exported on simple topics. 

Issue: Topics in tree layout are not centered in a slide. 

Resolved: Topics in tree layout are centered in a slide. 

Issue: Map is not responsive after applying a filter or selecting show/hide with maps that have an Org 

Chart layout. 

Resolved: Org Chart layout maps with filters or selections behave normally. 

Issue: Map layout is messy when using filter rules or show/hide others with Org Chart layout. 

Resolved: Org Chart layout maps with filter rules or show/hide have clean layout. 

Issue: Crash occurs in some cases of working with boundaries and relationships. 

Resolved: No crash occurs. 

Issue: Map layout becomes unstable when exiting from slide show. 

Resolved: Map layout behaves normally upon exiting from slide show. 

Issue: Saved filters do not appear under Filter drop down menu. 

Resolved: Saved filters appear under Filter drop down menu. 

Issue: Japanese: Date range menu becomes unusable in Create New Filter dialogue. 

Resolved: Date range menu is usable in Create New Filter dialogue. 

Issue: Frequent crash occurs when switching between app windows. 

Resolved: No crash occurs. 

Issue: Map rendering issue when dragging topic on expand/collapse connector. 

Resolved: No rendering issue occurs. 

Issue: Tags and relationship lines render improperly in Tree layout. 

Resolved: Tags and relationship lines render properly in all layouts. 

Issue: View > Zoom > Zoom In on map after viewing slide causes program to hang. 

Resolved: Program does not hang upon zooming in. 

Issue: MindManager hangs and must be forced quit when zooming in and out in a slide. 

Resolved: Zooming in and out behaves normally with no hanging. 

Issue: Drag and drop doesn’t work well. 

Resolved: Drag and drop now works very well. 

Issue: Map attachments not getting transferred. 

Resolved: Map attachments get transferred with no problem. 

Issue: Thumbnail tooltips in Chooser are too large. 

Resolved: Thumbnail tooltips are smaller size. 

Issue: Map isn’t editable after filter to one of topics in slide view is applied. 

Resolved: Map behaves normally when filter to one of topics in slide view is applied. 

Issue: Slide thumbnails remain even after topics containing these slides are deleted. 



Resolved: Slide thumbnails disappear after topics containing these slides are deleted. 

Issue: Relationship Inspector tooltip reads “Notes.” 

Resolved: Relationship Inspector tooltip reads “Relationships.” 

Issue: MindManager hangs when duplicating a slide thumbnail on a second attempt. 

Resolved: MindManager does not hang. 

Issue: Zoom menu is available in Outline View. 

Resolved: No longer available. 

Issue: Japanese: Word “Icons” is not localized. 

Resolved: Now localized. 

Issue: Topic selection does not hide when selecting “Hide Selected.” 

Resolved: Topic selection now hides when selected “Hide Selected.” 

Issue: German, Japanese: Template topics and subtopics expand in incorrect direction. 

Resolved: Template topics and subtopics expand properly. 

Issue: MindManager crashes after dragging topic in its boundary. 

Resolved: No crash occurs. 

Issue: Floating windows do not auto-hide when Slideshow is launched. 

Resolved: Floating windows auto-hide when Slideshow is launched. 

Issue: Tooltips take a long time to show up. 

Resolved: Tooltips appear faster. 

Issue: Zoom information does not update for next slide. 

Resolved: Zoom information updates for next slide. 

Issue: Changing zoom level to “Fit” in a map sets Slides to be shown in 400% zoom. 

Resolved: Zoom level appears as “Fit,” not at 400%. 

Issue: Export corrupts non-Roman title (i.e. Japanese title) of map causes system error when trying to 

open it. 

Resolved: Exports non-Roman titles normally. 

Issue: Footer doesn’t export properly to MS Word. 

Resolved: Footer exports normally.  

 

Known Issues in Version 9.5.416 
Issue: Some users may experience a problem seeing current Help content due to a quirk in the Apple 

Help Viewer. The problem is caused when the Help Viewer cache is not updated with the latest 

content.  Symptoms you may experience: 

•  After upgrading to MindManager 9.5 you are still seeing MindManager 9.0 Help content  

•  You get a “Help topic unavailable” message from the Help Viewer when using the 

MindManager help.  

• MindManager Help displays in the wrong language after you switch your system to a different 

language. 



Workaround: To overcome this problem, we are making a script available that will clear the Help Viewer cache.  

1. Go to the Mindjet Community for MindManager for Mac at 

http://community.mindjet.com/mindjet/products/mindjet_mindmanager_v_9_for_mac . 

2. On the right side of the screen, in the list of links, click “How to clear the Help Viewer cache” .  

3. The PDF with instructions and a link to the script will download. 

Issue: Cannot open Notes or Slides pane in Map View unless you select from Menu bar. 

Workaround: Select from Menu bar. 

Issue: Notes positioned on bottom open empty and without formatting toolbar. 

Workaround: Position Notes pane on the right. 

Issue: Notes pane does not hide when in Slide Show mode. 

Workaround: Close Notes pane before entering Slide Show mode, and do not open Notes while in Slide Show 

mode. 

Issue: Error upon exporting templates. 

Workaround: Edit template and save with a unique file name (not with template’s given name). 

Issue: JA, DE, FR: Bottom navigation controls disappear in Slideshow after first launch of Slideshow. 

Workaround: Use ESC key to exit and Up-Down keyboard controls to control Slideshow. 

Issue: Cannot access map when exiting Slideshow with a map that contains Notes and Slides. 

Workaround: Do not open Notes while in Slideshow mode. 

Issue: Save window doesn’t remember previous save location for new export. 

Workaround: Use drop down menu for “Recent Places” (OS option for shortcut to last used folder). 

Issue: Keyboard shortcuts use Up-Down arrows to flip through Slideshow, not Left-Right arrows. 

Workaround: None. 

Issue: Cursor remains visible during Slideshow when using keyboard shortcuts. 

Workaround: Pull cursor out of sight when presenting via Slideshow. 

Issue: If map is filtered, exiting from Slideshow removes Filter. 

Workaround: None. 

Issue: Files exported without extension. 

Workaround: None. 

Issue: Relationship shape is truncated in slide thumbnail. 

Workaround: None. 

Issue: Same output result when selecting export option for image “Export current map view” or “Export 

each slide as a separate image.” 

Workaround: None. 

Issue: Delete topic that is also a slide in map produces unexpected results (slide gets moved to Central 

topic). 

Workaround: Remove slide from topic, then delete topic. 

Issue: No <New Slide> option in application’s Menu bar. 

Workaround: Select desired topics and click <+> in Slides view, or <Ctrl-Click> and select “New Slide from 

Topic” from contextual menu. 

http://community.mindjet.com/mindjet/products/mindjet_mindmanager_v_9_for_mac


Issue: <Shift-Click> to select range of topics at once isn’t supported. 

Workaround: Rubber band selects all desired topics. 

Issue: Hyperlink doesn’t open topic in another map properly when “Absolute Hyperlink” checkbox is 

checked. 

Workaround: None. 


